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Abstract
Learn how to continue using Flex 3 even after the release of Flash Builder 4 and the disappearance
of Flex Builder 3.
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2 Preface
2.1 General
This lesson is part of a series of tutorial lessons dedicated to programming with Adobe Flex. The main
purpose of this lesson is to supplement the earlier lesson titled The Default Application Container - Flex 3
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and Flex 4
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with more information about the Flash Builder 4 IDE as well as information about the

FlashDevelop IDE.

Adobe released a new product named Flash Builder 4 in March of 2010 and immediately removed
all, or at least most of the references to Flex Builder 3 from their website. Those references that were
not removed were converted to references to Flash Builder 4. For example, the link (see Resources (p. 19)
) that previously opened an Adobe page for free downloading of Flex Builder 3 (for educational use) now
opens a page for free downloading of Flash Builder 4 for educational use.

What is Flash Builder 4?

Flash Builder 4 is an apparently upgraded version of Flex Builder 3 with a new name. Flex Builder 3
was based on Flex version 3, while Flash Builder 4 is primarily based on Flex version 4. However, Flash
Builder 4 still supports Flex 3 in addition to Flex 4.
Regardless of how you choose to get there, the objective is to create swf les that can be executed in the
Flash Player. Flash Builder 4 is only one of several dierent ways to create applications that will run in the
Flash Player.

The Flex 4 SDK and Flash Player 10

In conjunction with the release of Flash Builder 4, Adobe also released a new version (version 4) of the
free open-source Flex SDK and a new version (version 10) of the Flash Player.
Flex Builder 3 was based on Flex 3 and required Flash Player 9 (or later) for execution of the swf les
produced by compiling a Flex application.
Flash Builder 4 is primarily based on Flex 4 and requires Flash Player 10 (or later) for execution of the
resulting swf les.

Flash Builder 4 supports Flex 3

Fortunately, Flash Builder 4 still supports Flex 3 for backward compatibility. I will show you later in
this tutorial how to use Flash Builder 4 with Flex 3.

Should you use Flex 4?

If you are using Flex to create web applications in a professional capacity, you should probably become
familiar with Flex 4. It appears to provide some features that are not available in Flex 3.

More powerful but also more complicated

Flex 4 is more powerful than Flex 3. However, Flex 4 is also more complicated than Flex 3. In some
cases, Flex 4 also appears to create much larger swf les than Flex 3 for solutions to the same problems.
Therefore, I suspect that some developers will not make an immediate switch to Flex 4, and that Flex 3 will
continue to be commonly used for a few more years.
Beginning in the Fall 2010 semester, I will upgrade my Introduction to XML course to include both Flex
3 and Flex 4.

Flex is a cryptic shorthand programming language

The important thing to remember is that Flex (versions 3 and 4) is simply cryptic xml-based shorthand
programming languages that can be used to create some aspects ActionScript programs. You should also
remember that anything that can be programmed in Flex can be programmed directly in ActionScript.
However, the reverse is not true.
When Adobe released Flex 4 and Flash Builder 4, they actually added a large number of classes to the
ActionScript application programming interface (API) . So, the real question is not whether you should
use Flex 4. The real question is whether the new classes that were added to the API are useful in your
application. If so, use them. If not, stick with the classes that were part of the API before the new classes
were added.

Understanding Flex

If you really want to understand Flex (instead of simply using it in cookbook fashion) you need to learn
about object-oriented programming using ActionScript.
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2.2 Viewing tip
I recommend that you open another copy of this document in a separate browser window and use the
following links to easily nd and view the gures and listings while you are reading about them.

2.2.1 Figures
Figure 1 (p.
Figure 2 (p.
Figure 3 (p.
Figure 4 (p.
Figure 5 (p.
Figure 6 (p.
Figure 7 (p.
Figure 8 (p.
Figure 9 (p.

•
•
•
•
•
•
•
•
•

5) . Test program output for alpha values of 0.0, 0.33, 0.66, and 1.0.
7) . The FlashDevelop IDE at startup.
8) . The new project dialog.
9) . The FlashDevelop IDE for a new project named test.
11) . FlashDevelop text editor showing skeleton code for a Flex 3 project.
13) . Test program output displayed in the Flash Player.
14) . FlashDevelop showing the Debug/Release pull-down list.
16) . The New Flex Project dialog in Flash Builder 4.
18) . Contents of the project tree for the test program with Flash Builder 4.

2.2.2 Listings
• Listing 1 (p. 4) . Flex application named test.mxml.

2.3 Supplemental material
I recommend that you also study the other lessons in my extensive collection of online programming tutorials.
You will nd a consolidated index at www.DickBaldwin.com .
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3 Preview
You learned how to create a Flex project named AppBackground01 using Flex Builder 3 in the earlier
lesson titled The Default Application Container - Flex 3 and Flex 4 . However, Flex Builder 3 is no longer
available from the Adobe website.
Therefore, in this lesson, I will explain how to create the same Flex project in three dierent ways.
However, in this lesson, I will shorten the name of the project by changing the project name to test .
4

4 Discussion and sample code
Run the program

Before continuing, I suggest that you run (p. 1) the program to familiarize yourself with the screen
output.

Dierent ways to create Flex 3 applications

Here is a list of four dierent ways that you can create Flex 3 applications:
1.
2.
3.
4.

Use Flex Builder 3 if you already have it or can nd it on the web.
Download and use the free open-source Adobe Flex 3 SDK (see Resources (p. 19) ).
Download and use the free FlashDevelop IDE ( see Resources (p. 19) )
Download and use Flash Player 4 with the Flex 3 SDK ( see Resources (p. 19) )

3 http://www.dickbaldwin.com/toc.htm
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4.1 Download and use the free open-source Adobe Flex 3 SDK
It is relatively easy to use the free open-source Flex 3 SDK to compile an mxml document and create a swf
le that can be run stand-alone in the Flash Player. It is more dicult to deploy that swf le on a server.

Compiling an mxml le from the command line

The main claim to fame for XML is that XML les are plain text les. An mxml le is an XML le.
Therefore, you can create an mxml le containing mxml code, (such as that shown in Listing 1) , using
any plain text editor.
(The code shown in Listing 1 is the same as the code used in the Flex application in the earlier lesson
titled The Default Application Container - Flex 3 and Flex 4 .)
5

Listing 1: Flex application named test.mxml.
<?xml version="1.0" encoding="utf-8"?>
<mx:Application xmlns:mx="http://www.adobe.com/2006/mxml"

backgroundColor="#FF0000"
backgroundGradientColors="[#00FF00, #0000FF]"
backgroundAlpha="1.0">
</mx:Application>

A test program

Assume that you have created such a le named test.mxml and that you have stored the le in the
following folder on a Windows system:
C:\jnk\1\test.mxml

Download the zip le containing the Flex 3 SDK (see Resources (p. 19) ) and extract the contents of the
zip le into a folder of your choosing. That folder will then contain the following le:
...\bin\mxmlc.exe

Compile the test program

If you open a command-line window in the bin folder and execute the following command on the
command line, the mxml le will be compiled and a le named test.swf will be created in the same folder
as the mxml le:
mxmlc c:\jnk\1\test.mxml

If you have a stand-alone Flash Player (version 9 or later) on your system, you can open the le named

test.swf in that player.
Testing your installation

You should have no diculty using this approach to modify the backgroundAlpha values in the mxml
code shown in Listing 1 to produce swf les that produce the four gradient images shown in Figure 1 when
run in a stand-alone Flash Player version 9 or later. (Note that the four images shown in Figure 1 are
actually screen shots of the swf les running in a browser.)
5 http://cnx.org/content/m34604/latest/
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Test program output for alpha values of 0.0, 0.33, 0.66, and 1.0.

Figure 1:

Test program output for alpha values of 0.0, 0.33, 0.66, and 1.0.
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Four runs with dierent alpha values

For this example, the mxml code shown in Listing 1 was modied, compiled, and run four times in
succession by substituting four dierent values of backgroundAlpha into the code.

Four output images

The four images shown in Figure 1, going from left to right, top to bottom, represent alpha values of 0.0,
0.33, 0.66, and 1.0 respectively.

An alpha value of 0.0

For an alpha value of 0.0, the output color is pure red as shown by the top-left image in Figure 1. In this
case, the gradient color scheme is totally transparent.

An alpha value of 1.0

For an alpha value of 1.0, the output colors range from pure green at the top to pure blue at the bottom
as shown in the bottom-right image in Figure 1. In this case, the gradient color scheme is totally opaque
and the red background color doesn't show through at all.
(The image in the bottom-right corner of Figure 1 corresponds to what you should see if you
run the online version of this application as described earlier (p. 1) .)

Alpha values of 0.33 and 0.66

For alpha values of 0.33 and 0.66, the output is a blend of the red background and the green/blue gradient
as shown by the top-right and bottom-left images in Figure 1.

Deploying the swf le

If you don't have a stand-alone Flash Player on your system, or if you need to make the swf le accessible
from a web site, you will need to deploy the swf le in order to cause it to run in a Flash Player browser
plug-in .
6

The simplest case

In the simplest case, this will require you to create a JavaScript le and an html le. Templates for those
two les are provided in the Flex SDK folder with the following names and locations:
...\flex_sdk_3.5\templates\no-player-detection\AC_OETags.js
...\flex_sdk_3.5\templates\no-player-detection\index.template.html

I will leave it as an exercise for the student to read the online deployment instructions (see Application
Deployment in Resources (p. 19) ) and learn how to deploy the swf le.

4.2 Download and use the free FlashDevelop IDE
If you prefer not to work at the command-line level, another option is to download and use the free
FlashDevelop IDE (see Resources (p. 19) ) .

Works with the Flex SDK

The FlashDevelop program works in conjunction with the free open-source Flex SDK to make it easier to
create, compile, and deploy Flex applications than is the case when working from the command line. (The
version of the FlashDevelop program that is available in June 2010 is not compatible with the Flex 4 SDK.)

See the Getting Started website

After installing the FlashDevelop program, you should open the Getting Started website (see
Resources (p. 19) ) where you will nd instructions for conguring the program and getting it ready for
use.

The FlashDevelop IDE at startup

When you rst start the FlashDevelop program running, you will see an integrated development environment (IDE) that looks something like Figure 2.
6 http://www.adobe.com/products/ashplayer/
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The FlashDevelop IDE at startup.

http://cnx.org/content/m34631/1.1/

Figure 2:

The FlashDevelop IDE at startup.
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Create a new project

Selecting the Create a new project link on the right side of Figure 2 will open a dialog that looks much
like the one shown (in reduced form) in Figure 3.

The new project dialog.

Figure 3:

The new project dialog.

The text is dicult to read

Because of the reduced size, the text in Figure 3 is dicult to read. The highlighted item in the list in
the upper left reads "Flex 3 Project."

Select Flex 3 Project

Then enter the name and location of the new project in the text elds near the bottom of Figure 3, and
click the OK button. The IDE will change to look something like Figure 4.

http://cnx.org/content/m34631/1.1/

Connexions module: m34631

The FlashDevelop IDE for a new project named test.
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Figure 4:

The FlashDevelop IDE for a new project named test.

9

Connexions module: m34631

10

The project tree

Note in particular the tree structure shown on the right side of Figure 4 that is rooted in test (AS3) .
This tree structure replicates the tree structure that is created in the folder that was earlier specied as the
location for the project.

Re-opening the project later

However, that folder also contains a le named test.as3proj that is not shown in Figure 4. You can
double-click this le later to re-open the project in FlashDevelop.

Double-click the mxml le

The next step is to double-click the le shown in Figure 4 named Main.mxml . This will open that
le in a text editor as shown in Figure 5.
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FlashDevelop text editor showing skeleton code for a Flex 3 project.
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Figure 5:

FlashDevelop text editor showing skeleton code for a Flex 3 project.

11

Connexions module: m34631

12

Skeleton code

At this point, the text editor shown in Figure 5 contains the skeleton code for a Flex 3 project similar
to what you saw in Listing 1 of the earlier lesson titled The Default Application Container - Flex
3 and Flex 4 .
7

Modify and compile the program

Replace the skeleton code shown in Figure 5 with the code shown in Listing 1 (p. 4) above.
Then select Build Project on the Project menu.

Note the panel at the bottom of the IDE

You can drag and open a panel at the bottom of the IDE, if necessary, to expose the compiler output
text.
Quite a lot of text will appear in that panel.
If everything goes well, the last line of text in that panel will end with the words "Build succeeded" .

Test the program

Select Test Movie on the Project menu. If all goes well, The Flash Player should open and display
something very similar to Figure 6.
7 http://cnx.org/content/m34604/latest/#Listing_1
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Test program output displayed in the Flash Player.

Figure 6:

Test program output displayed in the Flash Player.

Create a Release Build

If you like what you see at this point, select Release in the pull-down list shown near the upper-right
corner of Figure 7 and build the project again.
This will modify the contents of the folder named bin shown in Figure 4. This new version of the folder
named bin can be deployed on a server.

http://cnx.org/content/m34631/1.1/
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FlashDevelop showing the Debug/Release pull-down list.

Figure 7:

FlashDevelop showing the Debug/Release pull-down list.

Executing the Flex project

The folder named bin contains a le named index.html as well as a swf le. You can open that html
le (p. 1) in a browser to play the Flash movie provided that the Flash Player plug-in, version 9 or later,
http://cnx.org/content/m34631/1.1/
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has been installed in the browser.
The swf le can also be opened directly in a stand-alone Flash player, version 9 or later.

What is the dierence between the Debug and Release builds?

While it is also possible to get an output that can be run in the Flash Player in Debug mode (the
opposite of Release mode) , the output produced in Release mode is normally smaller and more
compact.

Pros and cons of the FlashDevelop program

By now, you have probably concluded that the FlashDevelop program makes it easier to develop
and deploy Flex programs than is the case for the developing such programs from the command line.

Deployment made simple

In addition to providing a nice text editor, the program also handles the tedious task of creating the les
necessary to deploy the application and creates a folder named bin containing all of the necessary les.

The downside

The primary downside of FlashDevelop (relative to Flex Builder 3 or Flash Builder 4) , is that the
FlashDevelop program does not provide the drag-and-drop visual design mode for GUI components that is
provided by the two Adobe builder programs.

May or may not be important

Whether or not that is important will depend on the intended use of the IDE.
For example, students in my Introduction to XML course may consider that to be a serious shortcoming
because most of the lab projects in that course involve layouts for GUI components.
On the other hand, students in my ActionScript OOP programming course shouldn't have much need
for the drag-and-drop feature of the builder programs. That course concentrates more on programming
theory and less on drag-and-drop GUI construction.

4.3 Download and use Flash Player 4 with the Flex 3 SDK
Since Flex Builder 3 is no longer available for download from the Adobe website, those students who need
the drag-and-drop feature have little choice other than to use Flash Builder 4 in conjunction with Flex 3.
Therefore, I will tell you what I have learned through experimentation with Flash Builder 4.

Two dierent versions

To begin with, Flash Builder 4 can be downloaded in at least two versions. One version is a stand-alone
program. The other version is a plug-in for Eclipse. I am running the plug-in version, so some of the screen
shots that follow may be dierent from what you would see with the stand-alone version.

Similar to Flex Builder 3

Many aspects of Flash Builder 4 are very similar to Flex Builder 3, which you learned about in earlier
lessons. Therefore, I will concentrate on the dierences that I have identied.

Switch to the Flash perspective

When you start Flash Builder 4 for the rst time, you may be given an opportunity to "Switch to the
Flash Perspective." If so, you should make the switch. Otherwise, things probably won't go well at all.
(Once I learned that I needed to make the switch, I never saw that option again.)

Create a new Flex project

To create a new Flex project, pull down the File menu and select New/Flex Project .

Specify Flex 3.x

When the New Flex Project dialog appears, be sure to select Web and specify Flex 3.x (Flex
3.5 as of June 2010 but this may change over time) as shown in Figure 8.

http://cnx.org/content/m34631/1.1/
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The New Flex Project dialog in Flash Builder 4.
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Figure 8:

The New Flex Project dialog in Flash Builder 4.
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The Application server type

Unless you know a good reason to do otherwise, you should accept the default server type of None/Other
as shown in Figure 8.

Click the Finish button

After you provide the required information in the New Flex Project dialog , click the Finish
button at the bottom of the dialog. (Because of the way that I cropped the image, the Finish button is not
shown in Figure 8.)

Open the text editor

If necessary, select the Source tab at the top of the main panel to open the text editor in the main
panel as shown in Figure 9. This is essentially the same as Flex Builder 3. (The alternative is the Design
tab, which I discuss below.) Enter your mxml code in the text editor.

The Design tab

If you need to do drag-and-drop component layout, select the Design tab at the top of the main panel.
This will cause the lower-left panel to become a component panel and will cause the lower-right panel to
become a property panel in a manner similar to Flex Builder 3.

Build your project

Once you are satised with your component layout and your mxml source code, select Build Project
on the Project menu.

Run your project

Then select Run on the Run menu. This may cause a dialog titled Run As to appear on the screen.
(I don't recall seeing this dialog in Flex Builder 3.) If the dialog does appear, select Web Application
and click the OK button.
This should cause the application to open and run in your default browser provided that the browser has
the Flash Player plug-in, version 9 or later, installed.

Create a Release Build

If you are happy with what you see at this point, select Export Release Build... on the Project
menu. This will open another dialog titled Export Release Build which will probably contain the correct
information. Click the Finish button on this dialog to cause the release build to be exported.

The bin-release folder

Clicking the Finish button causes the folder named bin-release (shown in the project tree in Figure
9) to be created and populated.

http://cnx.org/content/m34631/1.1/
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Contents of the project tree for the test program with Flash Builder 4.

Figure 9:

Contents of the project tree for the test program with Flash Builder 4.

Deploying the project
http://cnx.org/content/m34631/1.1/
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The bin-release folder contains everything necessary to deploy the project on a server. Opening the
le named test.html in that folder will cause the Flash program to be played in a Flash Player browser
plug-in. In addition, the le named test.swf can be played in a stand-alone Flash player.

The bin-debug folder

The bin-debug folder that you see in Figure 9 also contains les named test.html and test.swf .
They can be opened in a browser and in a stand-alone Flash player to produce essentially the same results.

A smaller movie le

However, the test.swf le in the bin-release folder will often be much smaller and more compact
than the test.swf le in the bin-debug folder, resulting in shorter download times from the server.

5 Run the program
I encourage you to run (p. 1) the online version of the program. Then copy the code from Listing 1. Use
that code to create Flex projects for all three approaches. Compile and run the projects. Experiment with
the code, making changes, and observing the results of your changes. Make certain that you can explain
why your changes behave as they do.

6 Resources
I will publish a list containing links to Flex resources as a separate document. Search for Flex Resources in
the Connexions search box

7 Miscellaneous
This section contains a variety of miscellaneous materials.
note:

Housekeeping material

• Module name: Using Flex 3 in a Flex 4 World
• Files:
· Flex0103\Flex0103.htm
· Flex0103\Connexions\FlexXhtml0103.htm

PDF disclaimer: Although the Connexions site makes it possible for you to download a
PDF le for this module at no charge, and also makes it possible for you to purchase a pre-printed
version of the PDF le, you should be aware that some of the HTML elements in this module may
not translate well into PDF.
note:
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